
Errata for Math Mammoth Grade 7

7-A worktext

Chapter 1
Growing Patterns 1, p.26

The last line of the green box on the first page has: 
"Of course, this expression is more complicated than 2n + 1, but believe it or not, the two are equivalent!"

This should be with a minus sign: 
"Of course, this expression is more complicated than 2n − 1, but believe it or not, the two are equivalent!"

Answer key.

#6d. The expression (n + 2)² − n² was added to the list of possible answers.  

Chapter 2
Chapter 2 Review, p. 78

Answer for #11 was expanded to be:

11. The expression for the distance can be written as | −6 m − (−8 m) | or | −8 m − (−6 m) |.  It can be written even without
 absolute value, as −6 m − (−8 m) because we know which number is greater and we can subtract the smaller 
 number (−8 m) from the greater (−6 m). Each one of those will give the correct distance, 2 m. If we were dealing with
 variable(s), the distance would need to be expressed as the absolute value of the difference of the two quantities.

Chapter 3
Multiplication and Division Equations

Answer key, #6b.

This used to be:  … The total costs were $63,200. 
It was corrected to:  … The total costs were $63,600. 

Chapter 4
Multiply and Divide Rational Numbers 2, p. 135, Answer key

1. a. The answer in the long division is correct, 0.125. The answer given in the left side of the table was: 0.5 ÷ 4 = 0.0125.
This should be 0.5 ÷ 4 = 0.125.

Chapter 5
A Variable on Both Sides, p. 185

Answer key for #12.c. In the rightmost column there's a "| Ã· 2 " that needs taken off.



Some Problem Solving, p.187

The teaching box image was wrong and has been changed from 24,000 to 2,400.

Using The Distributive Property, p. 194

Answer key for #9.d. There was a division by negative 6 in the last column. Should be a division by 4.

Word Problems, p. 196

#1.b. The text used to read: “Mr. Sanchez spent exactly $35.” This was corrected to read:
“Mr. Sanchez spent about $35.”

7-B worktext

Chapter 6
Solving Problems Using Equivalent Rates, p. 15

#3. The first ratio used to have 8 miles/14 minutes. This was corrected to 8 miles/28 minutes.

Answer key.

#3. Used to say, “Jake will take 63 minutes to ride 36 miles.” 

This was corrected to: “3. Jake will take 126 minutes, or 2 hours 6 minutes, to ride 36 miles.”



Scaling Figures, p. 41

The answer key was expanded.

1. a. Example solution (proportion):

    b. Example solution: x = 238 cm/7 · 3 = 102 cm

2. The scale ratio 3:4 means that the sides of the smaller triangle are 3/4 the length of the sides of the larger triangle. 
    So we can just multiply each side of the larger triangle by 3/4¸ to get the lengths of the sides of the smaller triangle:

    (3/4) · (4.8 cm) = 3.6 cm, 
     (3/4) · (6.0 cm) = 4.5 cm, and
     (3/4) · (3.6 cm) = 2.7 cm. 

3. Answers will vary, but the corresponding angles of the two triangles must be equal, 
    and the sides of the larger triangle must be 5/2 = 2.5 times longer than the sides of 
    the smaller one. Please check the student's work.

4. a. 

  Length  Width Aspect Ratio 

Rectangle 1  1 cm 3 cm 1 : 3
Rectangle 2 1.5 cm 4.5 cm 1 : 3
Rectangle 3 2 cm 6 cm 1 : 3
Rectangle 4 2.5 cm 7.5 cm 1 : 3

    b. The aspect ratio for all four triangles is the same, 1:3.

5. a. x / 72 cm = 24 cm / 54 cm;   x = 32 cm.  
        There are three other ways to write a correct proportion and get the correct answer: 
        72 cm / x = 54 cm / 24 cm ;    x / 24 cm = 72 cm / 54 cm;   and  24 cm / x = 54 cm / 72 cm.

    b. x / 43 m = 16 m / 20 m;    x = 34.4 m. 

      There are three other ways to write a correct proportion and get the correct answer: 
        43 m / x  =  20 m / 16 m ;    x / 16 m = 43 m / 20 m;  and  16 m / x = 20 m / 43 m.

6. a. Scale factor = after / before = 14 cm / 6 cm = 7/3 ≈ 2.33.
    b. Scale ratio = after : before = 14 cm : 6 cm = 7:3.

7. a. Scale ratio = after : before = 15 ft : 20 ft = 36 ft : 48 ft = 3 : 4
    b. Scale factor = after / before = 15 ft / 20 ft = 36 ft / 48 ft = 3/4 = 0.75

8. If the area of the original square is 36 cm2, then each side must be 6 cm long. Each side of the 
    reduced square will be (3/4) · 6 cm = 4.5 cm. So the area of the reduced square is (4.5 cm)2 = 20.25 cm2. 
9. Please check the student's work. The size of the shape will vary according to how the page was printed. If the page was
    printed using a "scale to fit" or "print to fit" option, the actual measurements of the shape may not match what is 



    given below. However, the scale ratio and the scale factor should be the same or very close, even if the page wasn't 
    printed at 100%.

   The bottom sides of the two triangles measure 2.3 cm and 5.7 cm, 
    so the scale ratio is 57:23. The scale factor is 57/23 ≈ 2.5.

10. Please check the student's work. The size of the shape 
      will vary according to how the page was printed. If the
      page was printed using a "scale to fit" or "print to fit"
      option, the actual measurements of the L-shape may not 
      match what is given below. 

     The scale ratio 3:2 means the dimensions are multiplied
      by 3:2 = 1.5.  The bottom width and the height of the
      L-shape both are 5.7 cm. These become 1.5 · 5.7 cm 
      = 8.55 cm ≈ 8.6 cm.

    In inches, the bottom width and the height of the original 
      L-shape are 2 ¼ in and become 1.5 · 2 ¼ in = 3 3/8 in.

      See the image on the right.

 

11. a. The sides are in the ratio: after : before  =  ¾″ : 3″  =  1:4.

      b. Let x be the second side of the similar rectangle. Since the after : before ratio is 1:4, the longer side of the second
          triangle is one-fourth the longer side of the first triangle: x  = (4 ½)″ ÷ 4 = 1 1/8″.
          You can also solve this using the proportion x / (4 ½″)  =  (¾″) /  3″;  from which x = 1 1/8″. 
          These proportions work also: (4 ½″) / x  =  3 / (¾″)  or  x / (¾″) = (4 ½″) / 3″  or   (¾″) / x  = 3″ / (4 ½″). 

      c. Area of the original rectangle:  4 ½ in · 3 in = 13 ½ in2 = 13.5 in2.
          Area of the similar rectangle: ¾ in · 9/8 in = 27/32 in2  or 0.75 in · 1.125 in = 0.84375 in2.

      d. The areas are in the ratio: after : before = 27/32 in2  : 13 1/2 in2  = 27/32 : 27/2  = (27/32)  · (2/27) = 1/16 = 1:16.
          Or, using decimals, the ratio is after : before = 0.84375 in2 : 13.5 in2  =  0.0625 = 0.0625 : 1 = 1:16.
          So the ratio of the areas is the square of the ratio of the sides (square of the ratio 1:4).

Puzzle corner:
If the aspect ratio is 2:3, then the lengths of the sides are 2x and 3x. Thus the perimeter is
50 cm = 2x + 3x + 2x + 3x = 10x, so x is 5 cm. Therefore the sides are 10 cm and 15 cm long. 

Shrinking the rectangle at a scale ratio of 2 : 5 is the same as changing x from 5 cm to 2 cm, so the sides of the 
shrunken rectangle are 2 · 2 cm = 4 cm and 2 · 3 cm = 6 cm, and its area is 4 cm · 6 cm = 24 cm2.

 



Chapter 6 Review, p. 62

5. a.

Chapter 7
Review: Percent, p. 72

2. e. in the worktext should be 1039/10000

2. f. In the answer key, should be 340.9% = 3409/1000 = 3.409

Percent Equations, p. 82

ORIGINAL — which is not wrong, just convoluted:

12. Answers will vary. Please check the student’s work.

      Substituting numbers: Suppose the base b were 3 km and the height h were 4 km to give A = ½ bh 
      =  ½ (3 km · 4 km) = 6 km2. Increasing 3 km and 4 km by 10% gives the increased area A′ = ½ (3.3 km · 4.4 km)
      = ½ (14.52 km2) = 7.26 km2, which is an increase of 1.26 km / 6 km = 21%.

     Using algebra: The formula for the area of a triangle is A = ½ bh = 6 km2, where A is the 6-km2 area, b is
      the base, and h is the height. In this case we have A′ = ½ b′h′, where A′ is the area of the increased plot, b′ its
      base, and h′ its height. Because the increase is 10%, we know that b′ = 1.1b and h′ = 1.1h. If we substitute into 
      the formula for A′, we get A′ = ½ b′h′ = ½ (1.1b)(1.1h) = 1.21 (½ bh). Since A = ½ bh = 6 km2, we
      get A′ = 1.21 A = 7.26 km2. The size of the increased plot is 121% of the original plot, so the increase was 21%.

     Using logic: The easiest way to solve this problem is with a little insight: We see that when we increase b and h by
      10% in A = ½ bh, the new b and h are 110% or 1.1 times the old ones. Since the ½ in the formula doesn't change, 
      the new area is just 1.1 · 1.1 = 1.21 times the old area, so the increase is 21%.

NEW — improved and simplified:

12. Answers will vary. Please check the student’s work.

      Substituting numbers: Suppose the base b were 3 km and the height h were 4 km to give A = ½ bh 
      =  ½ (3 km · 4 km) = 6 km2. Increasing 3 km and 4 km by 10% gives the increased area A′ = ½ (3.3 km · 4.4 km)
      = ½ (14.52 km2) = 7.26 km2, which is an increase of 1.26 km / 6 km = 21%.

      Using algebra: The formula for the area of a triangle is A = ½ bh. Let's use b and h for the base and height of
      the original triangle, and b' for the base and h' for the height of the bigger triangle.



      Because the increase is 10%, we know that b' = 1.1b and h' = 1.1h. If we substitute those into the formula for the area, 
      we get area of the bigger triangle as Abig = ½ b'h' = ½ (1.1b)(1.1h) = 1.21 (½ bh). In the last expression, the part ½ bh
      is the area of the original triangle, so we can write Abig = 1.21 (½ bh) = 1.21 A, where A is the area of the original
      triangle.

      So, since area of the bigger triangle is 1.21A, that means it is 121% of A, which means the increase in area is 21%.

Percentage of Change, p. 86

Answer key for #3 was:

3 b. Since 20% of 5 kg is 1 kg, his weight at six months is 5 kg + 1 kg = 6 kg.

It was corrected to be:

3 b. Since 20% of 6 kg is 1.2 kg, his weight at six months is 6 kg + 1.2 kg = 7.2 kg.

Lesson: Comparing Values Using Percentages, p. 93

Answer key

4. WAS:    The difference in area is... 25%.
    SHOULD BE: 33%

    Also, in the same answer, the number 12,000 is incorrectly typed as 12.000

Chapter 7 Mixed Review, p. 103

The answer for exercise #6 was: 

b. | x − 7 | = | −2 − 7 | = | −9 | − 9

This was corrected to:

b. | x − 7 | = | −3 − 7 | = | −10 | = 10



Chapter 8
Angle Relationships, p. 117
Answer key.

WAS:
13. a. B = A = 109°       C = 180° − 109° = 71°       D = C = 71°∠ ∠ ∠ ∠ ∠

SHOULD BE:
13. a. B = 180° − A = 71°       C = A = 109°       D = B = 71° ∠ ∠ ∠ ∠ ∠ ∠

Basic Geometric Constructions, p. 123

Teaching box on the first page used to have:

Tips: 1. In MS Word, go to View → Toolbars → Drawing to see the drawing tools. 

This was updated to:

Tips: 1. In MS Word/LibreOffice Writer, go to Insert → Shapes or Insert → Drawing to see drawing tools. 

Answer key

#3. The instructions for the construction were clarified and updated to this:

3. On paper: 1. Draw a point, and two rays starting from it, to form an angle. This angle can be of any size. 
(Note we are not using a protractor when making geometric constructions.) 2. Draw any circle using the 
vertex of the angle as the center. 3. Mark the points where your circle intersects the two sides of the angle -- 
those are the two other vertices of the triangle. 4. Join the vertices with line segments. 

(within the image:)   a. Draw any angle by drawing two lines starting from the same point. 

Area of a Circle, p. 144
Question #1, student worktext had this text:

“After that, calculate the area
to the nearest hundredth of a square unit.”

This was changed to:
“After that, calculate the area
to the nearest tenth of a square unit.”

Answer key
Question #1.
WAS:    a. Estimation: 16 + 4 · 2 1/4 = 26 square units



                  Calculation: 28.26 square units

CHANGED TO:   a. Estimation: 16 + 4 · 2 1/4 = 26 square units
                                  Calculation: 3.14(3 · 3) = 28.26 square units ≈ 28.3 square units

WAS    b. Estimation: 2 · (8 + 7.5 + 5.5 + 3.5) = 49 square units
                 Calculation: 50.24 square units

CHANGED TO:  b. Estimation: 2 · (8 + 7.5 + 5.5 + 3.5) = 49 square units
                                 Calculation: 3.14(4 · 4) = 50.24 square units ≈ 50.2 square units

Proving the Formula for the Area of a Circle, p. 147

The teaching box that says "Proof, part 1" had this:

Why? The sectors alternate their orientations to put half of the original 
radius on the top of the parallelogram and half on the bottom. 

This was changed to: 

Why? The sectors alternate their orientations to put half of the original 
circumference on the top of the parallelogram and half on the bottom. 

Slicing Three-Dimensional Shapes, p. 167

Answer key for #3.b. This was added to the answer:

Please see https://www.geogebra.org/m/XCZwsytr#material/BtVjA79b for an excellent interactive 
showing all the possible cross sections of a cube.

Chapter 8 Review, p. 182, Answer Key

#10 Had this sentence: “The base of the parallelogram is half of the diameter of the circle, or ½C.”
The word “diameter” should be “circumference”:

“The base of the parallelogram is half of the circumference of the circle, or ½C.”

The Pythagorean Theorem, Applications, p. 209

The puzzle corner had an “impossible pyramid”, with edges 2.2 m long:

The four edges 2.2 m long would fail to meet in a single point. The 
calculation for the surface area was correct, though; it’s just that the 
pyramid in itself does not exist.



This was changed to a pyramid where the edges are 3.2 m long.
The calculation for the surface area in the answer key changed to:

Chapter 11
Review of Data Analysis, p. 255

The teaching box on the first page had this sentence:
“In the case of Jones family's expenditures, the interquartile range is $1195 − $1105 = $90.”

This was corrected to:

In the case of Jones family's expenditures, the interquartile range is $1,195 − $1,080 = $115. 

Also, the numbers under the boxplot were rounded to make the example easier to read.

They used to be: 
First quartile: $1,077.50
Third quartile: $1,192.50

They were changed to:
First quartile: $1,080
Third quartile: $1,195

Using Random Sampling, p. 267

#5 In the chart, sample 3 had 35 and 43. These were changed to 36 and 42 to match the answer key.



Chapter 11 Review , p. 291

Answer key for #4. b. was missing parentheses.

It was: "The average percentage of people who voted for Wilson is (13 + 16) ÷ 2/75 = 14.5/75.
It was corrected to: "The average percentage of people who voted for Wilson is ((13 + 16) ÷ 2) / 75 
= 14.5/75 = 19.3%.

Tests answer key
Chapter 2 Test

Question 7 was: 7. a. 14 b. −3

This was corrected to be: 7. a. 14 b. −4

Chapter 5 Test

Answer for question 1b.

The answer x = 2/17 is correct, but the last step in the solution is showing a division by 13 and that is 
incorrect... should be division by 17. 

Chapter 10 Test

#4b. The column total for "Experimental probability" says 100.6%, but should be 100.1%. 

End-of-Year Test

Both the test and the answer key.

#16 used "p" in description but "w" in equations.

All w's were changed to p.
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